
 

   

 

   
 NYSDOT Case Study: 

3D Design, Fabrication,  
and Virtual Assembly  
of a Steel Structure  
PIN: S3DF.VA 
Final Report 
February 2017 

Julius Chang, Eng.Sc.D., P.E.  
Principal Investigator 
HDR, Inc. 
500 Seventh Avenue  
New York, NY 10018-4502 

In association with 

MJ Engineering & Land Surveying, PC 
Upstate Detailing, Inc. 
Hirschfeld Industries, LP 
High Steel Structures, Inc. 

 
 
 

 

  
 

 

 

  

  

   

 

  



 
 

 

DISCLAIMER 

This report was funded in part through grant(s) from the Federal Highway Administration, United States 
Department of Transportation, under the State Planning and Research Program, Section 505 of Title 23, 
U.S. Code. The contents of this report do not necessarily reflect the official views or policy of the United 
States Department of Transportation, the Federal Highway Administration, or the New York State 
Department of Transportation. This report does not constitute a standard, specification, regulation, 
product endorsement, or an endorsement of manufacturers. 

  



 
 

 

 

 

 



 
 

 

hdrinc.com 500 7th Avenue, 15th Floor, New York, NY  10018-4502 
212-542-6000  

i 

Table of Contents 
Executive Summary ...................................................................................................................................... 1 
Introduction.................................................................................................................................................... 2 

Scope of Study .......................................................................................................................................... 2 
Background ............................................................................................................................................... 2 
Benefits ..................................................................................................................................................... 4 
Challenges/Obstacles ............................................................................................................................... 4 
Summary of Current Practice .................................................................................................................... 5 

Research Method .......................................................................................................................................... 5 
Overview ................................................................................................................................................... 5 
Part 1: Feasibility of Data Transmission ................................................................................................... 6 
Part 2: Fabrication and Verification ........................................................................................................... 9 

Study Findings ............................................................................................................................................ 10 
Statement on Implementation ..................................................................................................................... 10 

Designer’s Response .............................................................................................................................. 11 
Detailer’s Response ................................................................................................................................ 11 
Fabricator’s Response ............................................................................................................................ 11 

Recommendations and Conclusion ............................................................................................................ 12 
Glossary of Terms ....................................................................................................................................... 13 

 

 

List of Appendices 
Appendix A – Figures .................................................................................................................................A-1 

Appendix B – Detailed Outline of Methodology  ........................................................................................B-1 

Appendix C – Designer Workflow  ............................................................................................................ C-1 

Appendix D – Representative Scan Results  ............................................................................................ D-1 

 

 

 



 
 

 

hdrinc.com 500 7th Avenue, 15th Floor, New York, NY  10018-4502 
212-542-6000  

1 

Executive Summary 
This report documents a proof of concept study determining and documenting how electronic files 
containing steel bridge data can be transferred from designer to detailer to fabricator under New York 
State Department of Transportation (NYSDOT) current design/detailing practice to first fabricate and then 
verify a steel bridge girder section. Advances in Building Information Modeling (BIM) software and three-
dimensional modeling over the last quarter century offer the promise of a single source of project data 
from planning to design through construction and then facility management. In the case of steel 
fabrication, such a platform could increase efficiencies and reduce chances for error because the need to 
manually recreate or retype data is eliminated. This potential has, to date, been largely unrealized, and it 
is understood that a steel bridge has yet to be fabricated in the United States without continued reliance 
on 2-D paper drawings.  

Information for a 114-foot girder section was provided to the fabricator in a variety of CAD data file 
formats (DXF files and STEP) that included flange and web sizes and stiffener locations. A three-
dimensional model was also provided for reference and checking. Based solely on this information and 
without the use of 2-D paper drawings, a girder was fabricated at the Hirschfeld San Angelo shop in 
August 2016. The fabricated section was then scanned using a Faro laser scanner and was compared 
with the model generated by modeling software. Scan results are provided in Appendix D of this report. 
The laser scan provided validation that the fabricated girder was within the usual fabrication tolerances. 
For example, a representative report comparing top flange actual bolt hole locations to modeled locations 
indicates a maximum deviation of less than 1/16 inch. 

The study highlighted a number of areas that will require further consideration. First, many elements 
required for fabrication could not be shown, such as tension and stress reversal zones, weld testing limits, 
Mill to Bear/Tight Fit requirements, and even simple fillet welds between components. Consequently, this 
study only touched on the large amounts of metadata that would need to be included in making this whole 
process a system that could replace current NYSDOT means and methods. Second, it was evident that 
electronic data transfer will require closer coordination and continued back-and-forth communication 
among designer, detailer, and fabricator. One example is the location of the optional shop splice 
locations, which is based solely on the purchaser’s selection of economical locations.  

As the first documented fabrication of a steel bridge girder based solely on the transfer of electronic 
data—without the use of paper drawings—the study results represent an encouraging and important 
milestone in the pursuit of digital steel bridge fabrication.   
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Introduction 
Considerable advances have occurred over the last quarter century in building information modeling 
(BIM) software. Three-dimensional (3-D) models are routinely developed for visualization, for identifying 
spatial conflicts (such as a steel beam and an air vent), and for conventional analysis and design 
purposes. However, BIM’s true potential is to serve as a platform for life-cycle management by offering a 
single source of project data from planning to design through construction and then facility management. 
In the case of steel fabrication, such a platform could increase efficiencies and reduce chances for error 
because the need to manually recreate data is eliminated. This potential has been largely unrealized in 
the bridge world, and it is the study team’s understanding that a steel bridge has yet to be fabricated in 
the United States without reliance on two-dimensional (2-D) paper drawings. A number of challenges and 
obstacles must be overcome, including professional liability, file formatting, and data definition. One of the 
problems with electronic data transfer from the engineer is that the file is too rich in data and the detailer 
and fabricator need just a fraction of what is being generated. Accordingly, this report identifies what data 
are needed and demonstrates that such data can be transferred electronically from design through 
fabrication.  

Scope of Study 
HDR was asked by the New York State Department of Transportation (NYSDOT) as a task order under 
its on-call engineering services agreement (PIN: S3DF.VA) to conduct a proof of concept study 
determining and documenting how electronic files containing steel bridge data can be transferred from 
designer to detailer to fabricator under NYSDOT current design/detailing practice.  

HDR engaged the following firms to participate in the study effort: 

MJ Engineering & Land Surveying, PC (MJ), consulting engineer 
Upstate Detailing, Inc. (UDI), structural steel detailer 
Hirschfeld Industries, LP, steel fabricator 
High Steel Structures, Inc., steel fabricator 

The original scope was limited to a review and comment by the steel fabricator on the electronic data 
received from the designer and detailer for the web plate of an existing steel girder. An amendment to the 
original contract was issued expanding the scope to include the fabrication of a steel girder based on the 
transfer of electronic data and verification using a laser scanner. Specifically, the fabricator would: 

• Fabricate a steel bridge girder based on a DXF file(s) provided by the HDR team that included flange 
and web sizes, weld details, and stiffener locations.  

• Scan the fabricated section and compare it with the model generated by modeling software. 
• Confirm that the section had been fabricated in accordance with applicable standards and would be 

ready for shipping. 

Background 
For decades, the medium for transferring design information in the bridge industry has been paper. This 
design information, developed by the Engineer of Record, has been communicated by transferring it onto 
a set of contract documents—plans and specifications. All parties in the project, including the Owner, 
General Contractor, subcontractors, and material suppliers, are provided with this information via paper 
either in physical or electronic format. This continues to be the predominant practice in the bridge industry 
today, and the means by which structural steel fabricators receive the design information. 
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In traditional structural steel fabrication, the information shown on the contract plans is manually 
transferred into a fabricator’s internal system and software, and is developed into a set of fabrication shop 
drawings on paper by a detailer. The role of the structural steel detailer is to take the information shown 
on the Contract Plans—including the bridge geometry, material property and size requirements, and 
connection details—and create a complete set of shop drawings for each piece to be produced by the 
fabricator. Originally, this was accomplished through manual mathematical calculations and trigonometry. 
With the advent of computers, some of these calculations have been automated, and rather than using 
manual calculations, the design information is manually typed into structural steel detailing software/
systems by the detailer. Shop drawings, though, are still the product of the detailer’s work. The software 
systems have simply automated some of the manual processes used to calculate the necessary structure 
geometry, and, in certain cases, have automated some of the shop drawing generation. This continues to 
be the predominant practice in the industry today—that is, creation of 2-D shop drawings by a detailer 
using the information provided by the designer on the 2-D contract documents. 

While the process of creating shop drawings has been effective and, indeed, necessary for the steel 
fabrication industry, it certainly has disadvantages in its current practice: 

• Inefficient transfer of information – Design information/data, often available in digital format from the 
designer, is manually placed on contract plans by a designer, manually typed into software by the 
detailer, and, finally, manually placed back onto 2-D shop drawings for fabrication. 

• Increased risk of error – Simply by virtue of manually transferring the design data numerous times 
throughout the process, the opportunity for error is great. 

This process was effective in creating the shop drawings required for steel fabrication. These shop 
drawings were necessary because they were the communication tool used to provide direction for the 
manual structural steel fabrication in the shop. The 2-D shop drawings, therefore, were essential for the 
shop floor. 

However, with the advent of computer numerically controlled (CNC) equipment, the need for shop 
drawings has been diminished. CNC equipment is driven by computer code. Thus, fabricators continued 
to create shop drawings to be submitted for Owner approval and use, but subsequently created computer 
code by manual programming based on the information shown on the shop drawings. While the CNC 
equipment created great efficiencies in steel fabrication itself, it did necessitate an additional step in 
translating shop drawing information into computer code. At this stage in the Industry, which is 
representative of most fabricators today, steel fabrication is a combination of manual fabrication 
processes based on the information shown on the shop drawings, and CNC processes based on code 
developed from the shop drawings. The current workflow process is summarized in Figure 1. Figures are 
included in Appendix A. 

Today, the industry is on the cusp of an evolution, or revolution, in structural steel fabrication. With the 
software and data model developments associated with Bridge Information Models (BrIMs), the 
opportunity now exists to use the data inherent in these models directly for bridge fabrication. This BrIM 
technology and associated software packages provide opportunities to create any 2-D shop drawings 
necessary for fabrication, while, at the same time, creating CNC code to drive fabrication equipment. 
Software packages such as Tekla and SDS/2 have such capabilities. With this technology, it is now 
feasible to take bridge design information directly from the designer in data format, rather than paper 
format, and import it into detailing/modeling software. This eliminates the need to manually transfer 
information from 2-D contract plans into the detailing software. Thus, it is a means to capitalize on a new 
data flow process in the industry and on data sharing between project stakeholders. This is possible 
because of a convergence of the evolution and increasing use of CNC fabrication, and the evolution and 



 
 

 

hdrinc.com 500 7th Avenue, 15th Floor, New York, NY  10018-4502 
212-542-6000  

4 

development of data-driven software feeding the CNC equipment. Data sharing from the designer to 
fabricator further enhances and streamlines this process. The potential, preferred workflow process is 
summarized in Figure 2. 

Benefits 
The advantages of this data sharing for the steel fabrication industry include: 

• Increased efficiency – The need to manually recreate/retype design information from contract plans 
for use by the detailer and fabricator is eliminated; redundant handling of project data is eliminated. 

• Increased accuracy – The potential for error in manually recreating/retyping information is significantly 
reduced, if not eliminated.  

• Single source of project data – With this data flow and data sharing, it is now possible to generate a 
single data model of the project, with each subsequent stakeholder adding project data relative to his 
or her portion of the overall project. This data model can then serve as the Owner’s asset 
management tool. 

Challenges/Obstacles 
The challenges of implementing this data sharing and full utilization of BrIM in the industry include: 

• Professional liability – Processes of determining who is responsible for what portions of a project 
have been well-established and are readily apparent when dealing with paper. It is relatively easy to 
determine and define the documents of record on a paper-based project. New processes for 
establishing electronic documents of record and data of record will need to be created for a data-
based system. 

• File formats – Sharing information on paper is simple; ensuring file compatibility for data sharing is 
more complex and will require an open file format (for example, XML or IFC) such that all parties can 
access and use the information. The file format shared among members of a team cannot be in 
native software formats because each designer, Owner, General Contractor, fabricator, etc. may 
have different software packages. The key is to define an “open” file format that can be imported by 
each team member into his or her specific software. Each team member will need to develop the 
“translator” necessary to read the data file, and import it into his or her software package for the 
specific purpose. 

• Definition of needed data – The data needed by each stakeholder in the process, from upstream 
stakeholders, will need to be defined. In essence, the essential information shown on the contract 
plans will need to be replicated in the data file. 

• Quality control/quality assurance (QC/QA) – QC/QA processes have been developed based on paper 
and are relatively easy to complete, confirm, and verify on paper. New processes for QC/QA control 
of data-based systems will need to be developed. 

• Industry inertia – The bridge industry can be generally characterized as a conservative industry—a 
necessary and desirable characteristic when public safety is at stake. However, this can be 
challenging when striving to implement change. In general, the industry is accustomed to working 
with paper documents. Transitioning to a data-based process, which may include checking of data vs. 
checking of drawings, or submission of data vs. submission of drawings, will be challenging.  

• Risk transfer – Data sharing could essentially result in transfer of risk from the Contractor/fabricator to 
Engineer/Owner since current practice provides an independent check and identifies errors or 
omissions in the paper design. 
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Summary of Current Practice 
• During the typical design process, vertical and horizontal alignments are created in InRoads and are 

transferred to the bridge group in 2-D data sets. 
• Design is completed using software that either analyzes the structure using a Line/Girder Analysis or 

Grillage Analysis. 
• From that model/analysis, haunch tables, camber tables, shear/moment tables, and the contract 

plans for the superstructure are developed. The detailing of connections for cross bracing/diaphragms 
is not completely designed. For example, the bolt patterns and some gusset plates sizes for the cross 
bracing connections are not provided. This information is developed by the detailer. The member 
sizes and number of H.S. bolts are usually provided only in the contract plans. 

• The contract plans include all the above-listed tables, as well as the girder’s section properties, 
loading information, elevation, framing, etc. 

• Working from the hard copy 2-D plans, the detailer will typically use the roadway profile and 
horizontal geometry to develop the roadway surface and place the working points for the structural 
steel underneath. This serves as a check on the design. From the contract plans, the detailer has to 
remodel the superstructure, adding in bolt patterns and other miscellaneous details not included from 
the designer, to develop a data file for the fabricator to cut and assemble the steel for the structure. 
This is where redeveloping the model is extra work. 

• Detailer creates 2-D shop drawings for submittal to the fabricator. 
• Fabricators will generally require different information in a particular format. For example, in addition 

to hard-copy 2-D plans, certain fabricators request DXF files for plate members. Others, such as High 
Steel Structures, maintain a proprietary Coordinate Geometry (COGO) system.  

• With the advent of CNC equipment, the need for shop drawings has been diminished. CNC 
equipment is driven by computer code. Thus, while fabricators continue to create shop drawings to be 
submitted for Owner approval and use, they also create computer code by manual programming 
based on the information shown on the shop drawings. While the CNC equipment created great 
efficiencies in steel fabrication itself, it did necessitate an additional step in translating shop drawing 
information into computer code. At this stage in the Industry, representative of most fabricators today, 
steel fabrication is a combination of manual fabrication processes based on the information shown on 
the shop drawings and CNC processes based on code developed from the shop drawings. 

Research Method 
Overview 
• The study involved data gathered from two girders (G5 and G6) of a two-span, continuous steel 

multiplate girder bridge, carrying NY RT. 5/8/12 over Oriskany Blvd. The girders are 316'- 8" in length 
(Figure 3). The design provides for two field splices, so each girder line consists of three pieces that 
are 114'-0", 106'-6" (over the intermediate support), and 96'-2" in length. The test section girder for 
fabrication is the 114'-0" piece. The Top and Bottom flanges are both 1.5" × 16" and the Web plate is 
0.5625" thick and 60" deep. Bearing stiffeners (two required) are 1" × 7" and intermediate connection 
plates (three required) are all 0.5" × 7".  

The study was conducted in two parts. The objective of the first part was to verify that a graphical 
representation of a bridge member is a viable means of data transmission. The second part involved the 
actual fabrication of the steel girder and verification using a laser scanner. 
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Part 1: Feasibility of Data Transmission 
The study team initially assumed that NYSDOT had a 3-D model of the girder alignment. However, 
NYSDOT does not develop the 3-D geometry for the girders as part of its design effort and does not 
typically fully model girders in 3-D. NYSDOT has a deck surface and alignment file, and it copied the LAG 
file into a separate directory. This represented the starting point for the electronic data transfer process. 

Based on the information received, MJ (in the role of designer) developed 3-D graphic models for two of 
the girders, specifically girders G5 and G6. These girders were modeled in 3-D in preparation for a 
coordination meeting to understand what information the detailer, UDI, needed. 

The main goals of the meeting were to coordinate the relevant information needed by UDI and to 
understand what format UDI needed to develop information to produce shop drawings and coordinate 
with the fabricator. MJ displayed the model that had been developed based on the NYSDOT’s project 
files. The 3-D graphic representations of the girders were created using the Bentley InRoads program. 
The 3-D girders were positioned according to the contract plans and were based on the provided 
alignment (.alg) and digital terrain model (.dtm) files, using the top of the web at the centerline of the 
girder as the control point. 

It was agreed that, initially, MJ would submit the centerline of bearing and tenth point data to make sure 
they transferred successfully, and then add the additional data points required once the process and data 
submission format were established. This way, the beam’s basic information would be established and 
the rest could build off of that. Camber, haunch, moment, and shear tables were formulated from the 
design software, exported into Excel, and formatted into a table to be placed on the plans. UDI stated that 
this would be helpful information for its use when developing the model. It was noted at this meeting that 
the Excel files for the tables should accompany the beam models. Vertical alignments should be set up 
along the centerline of the girders at the bottom of the slab using the provided .dtm file from NYSDOT. If 
these elevations at the centerline of bearings and tenth points matched those in the provided haunch 
table, the first check would be completed and the alignments could then be dropped to the top of web to 
create the model. If the data did not check within the required tolerances, the .dtm should be 
reestablished on the deck with smaller template drop locations and checked. The current standard 
template interval is approximately 1.0'. 

The settled course of action was as follows: 

1. Create a horizontal alignment along centerline of one of the beams. 
2. Create a vertical alignment at top of deck slab. 
3. Translate the vertical alignment to bottom of deck slab. 
4. Generate report from InRoads at centerline of bearing and tenth points to check vs. the contract plan 

haunch table. 
5. If the vertical alignment data correspond within 1/16" of the elevations in the haunch table, translate 

the vertical alignment to the top of the web of the beam and then create the beam model. 
6. Generate report to be sent to UDI for its use in testing data transfer. 
7. If all worked successfully, add additional points to the first beam and duplicate the process for the 

second beam. 

The initial data set that was sent to UDI is shown in Figure 4. UDI requested additional information as 
noted below: 

• Bearing points 
• Points where girder horizontal geometry changes occur (PC, PCC, kinks, etc.) 
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• Field splices 
• Girder cross-section changes (flange transitions, web thicknesses, depth changes, etc.) 
• Diaphragm locations (at centerline of connection plate) 
• Miscellaneous points such as locations for intermediate stiffeners, scupper connections, utility 

supports, under deck lighting, etc. 
• Metadata information for the data points noted above, to eventually be provided with specific tags 

clearly denoting what the data point represents (for example, TFT_#1 could denote Top Flange 
Transition #1) 

• Data points, as provided, at the locations noted in camber table. The camber table data, in Excel 
format, should probably be presented in a table that is a “copy” of the tables presented in the contract 
plans. Four decimal places would be preferred over three to prevent mathematical rounding 
discrepancies down the road.  

Based on these comments, MJ transferred data as shown in Figure 5. 

Designer Workflow 
A workflow was developed for the procedure to create the InRoads reports that were submitted to the 
steel detailer UDI (see Appendix C to the report). The procedure was completed by another highway 
engineer to verify all pertinent information was provided and used to generate the information required for 
girder G5 (Figure 6). The workflow procedure is outlined below: 

• An attempt was made to create a generic procedure that could be followed regardless of the 
complexity of the structure: 

o The procedure was established based on a structure with two spans and continuous girders. 
o Additional detail may be required in the list of required points to cover structures that are not 

continuous. 

• The procedure took a highway engineer not familiar with bridge design ±2 hours from start to finish for 
a single girder: 

o This included calculations of all of the point stations (STEP 1), which accounted for about half of 
the time. 

o The engineer was experienced with InRoads. 
o If all of the station information is ready (STEPS 2 through 4 are completed prior to starting), the 

InRoads report process by itself could take 30 minutes or less per girder for someone familiar 
with the process and InRoads. Time savings for the detailer are yet to be quantified. 

• STEP 2, which involves calculating the stations of the tenth points and other significant points along 
the girder, will not be required when the designer puts this information together. He or she will have 
already calculated all of the stations of the required points during the design process and the data will 
only need to be compiled. 

• The elevations provided using this process are only as good as the bridge deck .dtm, or surface: 

o For example, the test structure bridge deck .dtm used did not take into account the 
superelevation changes near the beginning of the bridge and, therefore, some points were not 
within the 1/16" tolerances of the haunch table data. 

• If multiple points have the same station, multiple descriptions must be noted 
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• The test structure was on a tangent, making creation of the data more straightforward than a structure 
on a curve or a combination of tangents and curves. To simplify the horizontal alignment steps for 
structures not only on a tangent, the HCL could be made into a complex chain or linestring then offset 
to the centerline of the girders and trimmed to the limits of the girder at the beginning and end 
abutments. 

• When creating the vertical alignments, the final bridge deck surface must be copied down in the 
profile since the girders are directly below the bridge deck in the vertical plane. The copy parallel 
command must not be used. This applies to STEPS 12 and 13 when creating the vertical alignments 
for the bottom of deck and top of web. 

• This procedure could be done for a single girder for the entire length of the structure, regardless of 
the number of spans and continuity of the girders. 

Detailer Workflow 
An outline of the steps for creating DXF files from the designer’s coordinate data is provided below: 

1. UDI received XYZ coordinate data from MJ in Excel format (Figure 6).  

a. Data points provided were for locations of ‘Key-points’ along the girder lines. ‘Key-points’ 
including beginning and end of the girders, bearings, diaphragms, shop splices for material 
changes, field splices, and contract camber data locations. 

b. These ‘Key-points’ were provided in the “final” position. 
c. Metadata labels for each ‘Key-point’ were provided. 

2. UDI added the total deflection values as were provided in the printed contract design drawings 
(Figure 7 and Figure 8) at the 1/10th point locations.  

a. Deflection values for ‘Key-points’ not located at 1/10th point locations were extrapolated by UDI 
from a camber/deflection diagram created by UDI from the 1/10th point values. 

3. UDI adjusted each ‘Key-point’ location using local dead load rotations and the extrapolated deflection 
values to create revised ‘Key-point’ locations now in the “no-load” position. 

a. All data points were adjusted based on their relative position compared with the fixed bearing 
point(s) at Pier 1. 

4. Adjusted ‘Key-points’ coordinates in the “no load” position were imported into both Microstation and 
SDS/2 programs. 

5. The full web plate geometry was developed in both programs and the geometry was comparison 
checked between the two software platforms. 

6. For illustrative purposes (Figure 9), full 3-D modeling of all six girder pieces (two girder lines with two 
field splices per line) were completed with the addition of Flanges, Flange transitions, Field Splices, 
Stiffeners, and Connection Plates. 

7. 2-D AutoCad DXF files were created by both software platforms and provided as examples of 
possible output files that can be used by a fabricator as preliminary import data. A screenshot of one 
of the DXF files is shown in Figure 10. 

DETAILER ISSUES AND OBSERVATIONS 
1. In the Detailing Outline, STEP 1 was to “Import designer’s model.” 

a. This step does not exist within current NYSDOT operations. The bridge superstructure is not 
required to be modeled in any format that could be transmitted downstream. Larger design/build 
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projects such as the Tappan Zee Bridge replacement are developed to proceed along a shared 
model basis since the design/build team is to function as a single entity. 

b. All of the ensuing steps within the Detailing Outline follow suit with the above Note a. Within the 
confines of the data available, UDI “followed” the detailing outline. 

c. Modeling programs that can dynamically adjust a modeled structure following the material 
properties of a bridge superstructure do not exist. This leads to duplication of model information 
when the designer would create the “Final” position model, the detailer would need to create 
several other models, “No-load,” “Erected,” etc. These are further complicated by the fabricator’s 
need to make additional changes to the modeled members to account for construction tolerances 
and fabrication processes. 

2. Deflection data should be provided at all ‘Key-points’ to eliminate the need for extrapolation. 
Extrapolation is not appropriate in all cases because it can lead to errors. 

3. Means and methods for calculating the adjustments to the ‘Key-points’ involve calculation of the local 
grades at all ‘Key-points’ in all of their dynamic positions required. The local grades vary depending 
on vertical curves, superelevations, and dead-load deflection states. All of these elements complicate 
the geometrical calculations of each ‘Key-point.’ 

4. The model output, whether in a DXF file, VRML, CIS/2, or any other output format from the detailing 
model must be further adjusted by the fabricator, erector, or contractor. No data stream remains 
unchanged because it flows throughout the project and, regardless of the format, must be adaptable 
to remain usable by all subcontractors involved in the project. 

Fabricator Workflow 

INITIAL REVIEW OF DATA 
The fabricator received three DXF files from the detailer representing three sets of web plates that make 
up Girder 5. After performing some checks on the dimensions and a check of the entire girder line to do a 
comparison from the DXF model to what a fabricator actually scans in shop for girders, the fabricator 
generated a nesting diagram (Figure 11), which shows how a piece would be cut out of a rectangular 
piece of steel. What has been demonstrated at this point is that the graphical representation of a bridge 
member is a viable means of data transmission. The fabricator received this transmission in form of DXF 
file and, after some proprietary modifications, confirmed that he could proceed to fabrication.  

Part 2: Fabrication and Verification 
Based on the results from Part 1 verifying that a graphical representation of a bridge member is a viable 
means of data transmission, a change order was issued to proceed with fabrication and verification of the 
test girder. As a cost consideration, it was decided to fabricate only the 114-foot section of the G5 girder 
line. The Top and Bottom flanges are both 1.5" × 16" and the Web plate is 0.5625" thick and 60" deep. 
Bearing stiffeners (two required) are 1" x 7" and three required intermediate connection plates are all 
0.5" × 7". 

Certain modifications needed to be made to the files that were established in Part 1. First, the fabricator 
provided shop splice locations to the designer. Figure 12 includes the coordinates for field splices on the 
114-foot section that were provided to the detailer. There was coordination between the detailer and 
fabricator on the format, information, and conventions for fabrication. All components were welded using 
5/16" fillet welds, with the exception of web and flange butt splices. The stiffeners were modeled as “Mill 
to bear” at the bottom flange. Additionally, there was no check of the hole patterns in the connection 
plates since the diaphragms were not modeled.  
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Separate DXF files and STEP files were provided for each girder plate (top flange, bottom flange, stiffener 
plates) as well as a 3-D model for reference and checking (Figure 13). In the DXF files, for the ends of the 
web and flange plates, the plates were extended by 3" (to account for shrinkage) and a scribe line was 
shown for the projected cutline. On the web plates and bottom flange plates, similar scribe lines were 
shown to locate the position and orientation of the connection plates and stiffeners. The fabricator 
required about an hour to modify the models sent from the detailer, including proprietary camber 
adjustments due to shrinkage. The files were then imported into a CNC machine. Figure 14 is a photo 
taken during the fabrication process.  

Study Findings 
Girder fabrication was completed at the end of August 2016. Full laser scanning of the girder was 
conducted during available work crew periods in the first three weeks of September. Representatives 
from HDR and UDI witnessed girder verification on September 30, 2016. The finished girder (in lay-down 
position) is shown in Figure 15. Figure 16 is a photo showing the bolt holes for the field splice. The 
fabricated section was scanned using a Faro laser scanner and then compared with the model generated 
by modeling software (Figure 17). Representative scan results are provided in Appendix D of this report. 
The laser scan provided validation that the fabricated girder was within the usual fabrication tolerances.  

The study highlighted a number of areas that will require further consideration. First, there were many 
elements required for fabrication that could not be shown—such as tension and stress reversal zones, 
weld testing limits, Mill to Bear/Tight Fit requirements, and even simple fillet welds between 
components—so this study only touched on the large amounts of metadata that would need to be 
included in making this whole process a system that would replace the current NYSDOT means and 
methods. 

For the DXF of x1a, the wrong face of the stiffener was inadvertently exported and identified during the 
fabricator’s review. Due to the beveled edge against the web of the girder, one face is narrower than the 
7" stiffener width. The beveled edge—and how to show that on a 2-D DXF file—is one of the many issues 
that this methodology faces moving forwards. It is not possible to show a beveled edge other than to 
add the parallel “edge” shown differently. How this gets interpreted into CNC is problematic.  

Second, it became evident during the course of the study that electronic data transfer will require closer 
coordination and continued back-and-forth communication among the designer, detailer, and fabricator. 
One example is the location of the optional shop splice locations, which is based solely on the 
purchaser’s selection of economical locations.  

What also became clear in witnessing verification is the great potential in the use of laser scanners in 
conjunction with a 3-D model to measure girders in the fabrication shop. Fabricators must demonstrate fit 
up of connected members in the shop. As demonstrated in Figure 18, a full-size lay down of a connected 
member can require considerable shop space. As demonstrated in this proof of concept study, laser 
scanning can measure fabricated sections that in turn can be used to detail the connection plates, 
thereby ensuring proper fit-up.  

Statement on Implementation 
The study team participants provided responses regarding the question of what would need to transpire in 
order for the bridge industry to achieve the ultimate objective to transfer data seamlessly from design to 
fabrication. 
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Designer’s Response 
Ideally, it would be beneficial to keep all information in only one or two interfaces, at least between the 
designer and fabricator. We envision a modification to existing software programs or development of new 
ones to limit the number of interfaces. For example, if a program similar to MIDAS or CSiBridge were 
created and then used—which would have the capabilities to develop a structural model, design the 
structure, and create all the necessary tables that could be exported to Microstation V8i for use in the 
contract plans, as well as be available for the detailer’s use—the information would be from a singular 
interface and would reduce possible data transferring issues. This modeling program would be a hybrid 
between a design software and BrIM software, and would be required to detail/design everything from the 
main girder system to the bolts of the splices/cross frames in order to allow for complete fabrication of the 
structure. The software would also have to be able to develop COGO points for each major elements 
(10th points, splice locations, diaphragm/connection plate locations, etc.) that would be placed in a table 
to be easily converted into the necessary file type for the fabricator. 

The previously mentioned software interfaces already have a function to look at staged construction, so 
that could be used in developing points for the no-load condition, as well as during staged deck pouring. 
This model could also be forwarded onto the detailer, who could then import it into which ever file type 
needed by the fabricator for fabrication, as well as used for making shop drawings. 

The limitation of this software is that it would likely be proprietary and quite expensive considering the 
cost of the software packages of MIDAS and CSiBridge, which can do quite a bit and get to a point of 
modeling/design. This software would have to go even further.  

This process would also eliminate one step that detailers typically perform under the current approach. 
The detailer typically provides an independent check of the design by using the information provided in 
the contract plans to construct the model and provide additional details that are then sent to the 
fabricator. During the process of developing the model, the detailer may notice some inconsistencies that 
can be worked out with the designer prior to sending the information for fabrication. Using this “euphoric” 
approach, the sole responsibility of the design and QC/QA process will lie mainly with the designer, with 
the detailer acting mainly as a middle man, just converting the model to the necessary file type for the 
fabricator. The fabricator would mainly use the model provided by the designer, and then the designer 
would check the shop drawings. The independent review of the design would be eliminated from the 
process unless the detailer would be used solely as a check of the data and model prior to transferring to 
the fabricator to provide an independent check.  

Detailer’s Response 
Bridge model data—accessible to all involved with the project—hosted by NYSDOT would be an entry 
point. This would then be expanded to several models: “No-load,” “Fabricated,” “Erected,” etc. to then 
extract each party’s data needs. Designers develop their “model” based on the final finished condition, but 
this condition needs significant modification to become an as-built reality. In a true “paperless” 
environment, software would exist that could move and adjust all members within a model based on the 
various positions: final, erected, no-load. Dead-load rotations would be accounted for. Crossframes would 
adjust for differential deflections. Girders would roll in and out of plumb as deflections and member 
strengths allow. Our view is that software with that capability will not be available in the near future. 

Fabricator’s Response 
Although challenges to effectively implementing this new data-based technology are numerous, the 
opportunities are seemingly endless for the structural steel fabrication industry when considering the 
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continued development of CNC and robotic equipment and processes. A few examples of how these 
data-driven processes can be used in structural steel fabrication include: 

• Automated cutting/burning of webs, flanges, parts, rolled shapes 
• Automated drilling, punching, milling 
• Automated placement of parts into an assembly 
• Automated or robotic building and welding 
• Automated or robotic blast cleaning and painting 
• Virtual/digital measurement of as-fabricated pieces and comparison to theoretical for quality checks 
• Virtual assembly of as-fabricated pieces for verification of fit 
• Digital fabrication records (e.g., QC documents) for storage with project files/data model 

Recommendations and Conclusion 
The results of this study provide impetus for further research of this kind. Since only the first part of a 
girder line was fabricated as part of this scope of work, the next step would be to undertake the 
fabrication and virtual assembly of an entire girder line. A subsequent step would be to digitally fabricate 
and assemble a two-girder bridge of 75 to 100 feet that would include the modeling and assembly of 
cross frames. As the first documented fabrication of a steel bridge girder based solely on the transfer of 
electronic data and without the use of paper drawings, the results of this study represent an encouraging 
and important milestone in the pursuit of the digital steel bridge fabrication.   



 
 

 

hdrinc.com 500 7th Avenue, 15th Floor, New York, NY  10018-4502 
212-542-6000  

13 

Glossary of Terms 
BrIM (Bridge Information Modeling) 
A three-dimensional model of a bridge that is linked to a wide variety of data. 

COGO (Coordinate Geometry) 
A suite of programs used in civil engineering to solve coordinate geometry problems.  

CNC (Computer Numerical Control) 
CNC is one in which the functions and motions of a machine tool are controlled by means of a prepared 
program containing coded alphanumeric data. CNC can control the motions of the work piece or tool.  

Digital Fabrication 
Broadly speaking, the use of a digital model to automate fabrication processes. Examples include: 
• Automated cutting/burning of webs, flanges, parts, rolled shapes 
• Automated drilling, punching, milling 
• Automated placement of parts into an assembly 
• Automated or robotic building and welding 
• Automated or robotic blast cleaning and painting 
• Virtual/digital measurement of as-fabricated pieces and comparison to theoretical for quality checks 
• Virtual assembly of as-fabricated pieces for verification of fit 
• Digital fabrication records (e.g., QC documents) for storage with project files/data model 

Virtual Assembly 
Digitized information of an as-fabricated piece is back-fed into software to check against the theoretically 
fabricated piece. 

Virtual Design and Construction 
The management of integrated multidisciplinary performance models of design-construction projects, 
including the product (i.e., facilities), work processes, and organization of the design-construction-
operation team to support explicit and public business objectives.
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Figure 1  Current Workflow 

 

 

 

 

Figure 2  Preferred Workflow 
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Figure 3  Test Girder Elevation 
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Figure 4  Initial Data Set Sent to UDI 
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Figure 5  Girder 6 Data Points with Additional Data Points 
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Figure 6  Girder 5 Data Prepared from User Manual 
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Figure 7  Deflection Values from Contract Design Drawings 
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Figure 8  Coordinate and Camber Data for Girder 5
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Figure 9  3D Modeling of Girder Pieces 
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Figure 10  DXF File Screenshot 
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Figure 11  Nesting Diagram 
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Figure 12  Coordinates for 114' Section, including Shop Splice Locations 
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Figure 13  Screen Shot of 3-D Model Sent to Fabricator 
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Figure 14  Fabrication of Test Girder Plate 
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Figure 15  Finished Girder in Lay-Down Position 
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Figure 16  Girder End Showing Bolt Holes for Field Splice 
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Figure 17  Girder Verification Using Laser Scanner 
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Figure 18  Girder Fit-Up in Shop 
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Appendix B 
Detailed Outline of Methodology 
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I. Outline of Methodology 
a. Description of Sample Project 

i. NY Route 5/8/12 over Oriskany Blvd 
ii. Two-span continuous girder bridge 
iii. Modeling of two girder lines and cross frames 

b. Outline of Work Flow 
i. Hard copy of drawings 
ii. Electronic files from NYSDOT 

1. 3-D Deck surface and alignment file 
iii. Designer developed 3-D graphic models for girders G5 and G6  using Bentley InRoads 

program 
iv. Designer created horizontal alignment along centerline of G6 
v. Designer created vertical alignment at bottom of deck slab for G6 
vi. Designer generated report from InRoads at centerline of bearing and tenth points to check 

versus the contract plan haunch table 
vii. Designer confirmed for G6 that the vertical alignment data corresponded to within 1/16" of the 

elevations in the haunch table 
viii. Designer created another vertical alignment at the top of the web of the beam 
ix. Designer created G6 beam model 
x. Designer formulated model as an InRoads file and generated report initially as a text file  
xi. Designer placed text file in Excel format based on detailer’s request  
xii. Designer submitted report for G6 (Figure 4) in Excel format with information on northing, 

easting, and elevations at centerline of bearings and tenth points along girder to steel detailer 
as a test of data transfer 

xiii. Detailer confirmed that points were successfully imported and is usable data for them to 
develop information for the fabricator 

xiv. Detailer requested additional data points 
xv. Generated report for G6 (Figure 5) with additional data points in Excel and sent to detailer 
xvi. MJ developed a workflow for the procedure used to create the InRoads report 
xvii. Report for Girder G5 was developed (Figure 6) based on the workflow and submitted to 

detailer 
xviii. Detailer performed calculations to translate final position data from MJ to no-load position 

data 
xix. Detailer modeled no-load position 
xx. Detailer provided web and flange DXF files to fabricator for “fabrication” 
xxi. Fabricator generated a nesting diagram and confirmed that he could proceed to fabrication 

with information provided 
xxii. Fabricator provided shop splice locations  
xxiii. Team agreed to use 5/16" fillet welds at all weld locations other than for butt splices 
xxiv. Designer submitted coordinates for girder section including shop splice locations 
xxv. Detailer provided individual DXF files and STEP files for each plate as well as 3-D model to 

fabricator 
xxvi. Fabricator imported files into CNC machine 
xxvii. Girder is fabricated and dimensions validated using laser scanner 
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Appendix C 
Designer Workflow 
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Steps for Creating InRoads© Data Report for 3D Girder Points 

1. Verify Digital Terrain Model (DTM) triangulation intervals for the bridge deck surface.  Template 
drops shall be at 1’-0” intervals. 

a. Open a 2D Microstation© file and load InRoads© 
b. Load the Bridge Deck DTM file and project ALG file 
c. In the InRoads© window, choose “Surface” > “View Surface” > “Triangles” 

 

d. The View Triangles dialog opens 
i. Click “Apply” 

 

ii. Measure between triangle vertices along a line parallel to the project alignment 
to ensure that the template intervals are 1’-0” drops 

2. Calculate stations based off the roadway HCL for the following locations to four decimal places: 
a. Start of Beam 
b. Centerline of Begin Bearing 
c. Centerline of Pier(s) Bearing, if necessary 
d. Centerline of End Bearing 
e. End of Beam 
f. Horizontal Geometry Changes in Beam (Check Project Alignment) 

i. PC 
ii. PCC 
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iii. Kinks, etc. 
g. Field Splices 
h. Girder Cross-Section Changes 
i. Diaphragm Locations (at centerline of connection plate) 
j. Miscellaneous Points 

i. Intermediate Stiffeners 
ii. Scupper Connections 

iii. Utility Supports 
iv. Under Deck Lighting, etc. 

3. Calculate stations for tenth points of all spans to four decimal places 
a. These tenth points may coincide with other point mentioned in STEP 2 above.  When 

this occurs, these points shall be represented by one station having multiple 
descriptions. 

4. Save stations is ascending order in Excel© with Point Names. See sample table below. 
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STEP  3.a. 
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5. Create a text file with the stations from STEP 4 
a. Copy columns 2 & 3 and paste into new Excel© file in the upper left cell.  This data must 

be pasted as VALUES using the Paste Special command in Excel© 

b. Click on the  symbol in Excel© and choose “Save As” 

 

 

c. In the Save As dialog box, navigate to the project directory where you want to save your 
file 

d. Under “Save as type:” dropdown menu, choose “Unicode Text (.txt)” 
e. Type in the file name “Girder X”, where X represents the Girder number 

 

 

 

STEP  5.c. 

STEP  5.e. 

STEP  5.d. 

STEP  5.b. 
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f. The following messages will appear after you click save.  Click “OK” on the first and 
“Yes” on the second. 

 

 
 

6. Create a geometry project:  In the InRoads© window, choose “File” > “New” 

 

 

 

 

 

 

 

 

 



PIN: S3DF.VA Appendix C-Designer Workflow 

Page 6 of 25 

a. Under Type, select “Geometry Project” 
b. Enter in the name of the geometry project as shown below using the Project 

Identification Number (PIN) 
c. Click “Apply” 
d. Click “Close” 

 

7. Reference in the framing plan and create a line or linestring over the girder for the entire length 
of the bridge from start of girder to end of girder.  A line can be utilized for bridges with 
alignments on a tangent section and linestrings will be utilized for bridges with alignments that 
have a combination of tangents and curves. 

8. In the InRoads© window, click on “File” > “Import” > “Geometry” 

 

 

 

STEP  6.b. 

STEP  6.a. 
STEP  6.c. 

STEP  6.d. 
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The following dialog box will appear: 

 

a. Under Type, make sure “Horizontal Alignment” is chosen 
b. Under Geometry, type in the name of the alignment consisting of the project pin 

number followed by an underscore and then “Girder X” where X represents the girder 
number for the alignment being imported (see picture above) 

c. Under Target, Select the geometry project created in STEP 6 
d. Click “Apply” then select the line or linestring drawn in STEP 7 
e. Click “Close” 

9. Set the stations to coincide with the roadway centerline stationing 
a. In the InRoads© program window, choose “Geometry” > “Horizontal Curve Set” > 

“Stationing” 

 

 

 

STEP  8.a. 

STEP  8.b. 

STEP  8.d. 

STEP  8.c. 

STEP  8.e. 
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b. At the bottom of the Stationing dialog box, click new 

 

c. In the Add Station Equations dialog box, set the Back Station to 0+00.00 
d. Set the Ahead Station to station calculated for the start of beam from STEP 2 
e. Click “Apply” on Add Station Equations dialog 

 

 

 

 

 

 

 

 

 

STEP  9.c. 

STEP  9.d. 

STEP  9.e. 

STEP  9.b. 
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f. Click “Apply” on Stationing dialog 
g. Click “Close” on Stationing dialog 

 

10. Cut a profile along the alignment created in STEPS 7-9 
a. In the InRoads© program window, choose “Evaluation” > “Profile” > “Create Profile” 

 

 

 

 

 

 

 

 

 

 

STEP  9.f. 

STEP  9.g. 
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b. Load the preferences you want the profile to display 

 

c. Under “General” in the left pane: 
i. Set the Exaggeration to 1 for Vertical and Horizontal 

ii. Select the bridge deck surface to be displayed 

  

 

 

 

 

 

 

 

STEP  10.c. 

STEP  10.c.i. 

STEP  10.c.ii. 

STEP  10.b. 
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d. Under “Controls” in the left pane: 
i. Click “Use” under the Elevation section and set the elevations according to the 

project elevations.  These elevations shall be set to ensure the proposed surface 
is visible for the entire length of the girder alignment created in STEP 8. 

ii. Click “Use” under the Station section and verify the stations are for the entire 
length of beam 

iii. Click “Apply” under the Window Clearance section and set the Top and Bottom 
values to 2 

iv. Click “Apply” at the bottom of the Create Profile dialog 
v. Click inside Microstation© design space where you want the profile to appear 

vi. Click “Close” at the bottom of the Create Profile dialog 

  

 

 

 

 

 

 

 

 

 

 

 

 

STEP  10.d.i. 

STEP  10.d.ii. 

STEP  10.d.iii. 

STEP  10.d.iv. 

STEP  10.d.vi. 

STEP  10.d. 
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11. Create a Vertical Alignment for the TOP OF DECK along Girder X:  In the InRoads© window, click 
on “File” > “Import” > “Geometry” (see STEP 8 for picture) 

a. Make sure the alignment created in STEP 8 is active.  This shows up under the Target 
section 

b. Under Type, make sure “Vertical Alignment” is chosen 
c. Under Geometry, type in the name of the alignment as shown in screen shot below 
d. Make sure “All Selected Elements Added to Single Alignment” is checked 
e. Click “Apply”, the dialog will disappear 

 
 

f. select the line in profile created in STEP 10 
g. Left Click to Accept line 
h. Right Click to reset and the Import Geometry dialog will pop up 

 

 

 

 

 

 

 

 

 

 

STEP  11.b. 

STEP  11.c. 

STEP  11.e. 

STEP  11.a. 

STEP  11.d. 
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12. Create a Vertical Alignment for the BOTTOM OF DECK along Girder X:  In the profile created in 
STEP 10, copy the deck surface down a distance equal to the depth of the structural slab.  DO 
NOT use the copy parallel command as the girders are directly below the top surface in the 
vertical plane and will match the profile of the top of deck.  Repeat STEPS 11.a. thru 11.d. 
utilizing the name shown below 

 

13. Create a Vertical Alignment for the TOP OF WEB along Girder X:  In the profile created in STEP 
10, copy the bottom of deck surface down a distance equal to the haunch plus the top flange 
and repeat STEPS 11.a. thru 11.d. utilizing the name shown below 

a. Click “Close” 

  

STEP  13.a. 

STEP  12 

STEP  13 
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14. When you are done importing the Vertical Alignments, your InRoads© geometry tab should look 
like this for GIRDER X 

a. Make “PIN_GIRDER X_T/WEB” vertical alignment active as shown below 

 

15. In the InRoads© window, click on “File” > “Text Import Wizard” 
a. Under Data Type, choose “Vertical Event Points” 
b. Under filename, navigate to the text file created in STEP 5 
c. Click “OK” 

 

 

 

 

 

 

 

 

 

 

 

STEP  15.c. 
STEP  15.a. 

STEP  15.b. 

STEP  14.a. 
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d. The Text Import Wizard – Step 1 of 4 dialog will open 
i. The picture below shows the default set up 

ii. Verify your window looks like this and all stations show up 
iii. Click “Next” 

 

e. You will proceed to the Text Import Wizard – Step 2 of 4 dialog 
i. Under the Original Data Type, select “Fixed Width” 

ii. Verify your window looks like this and all stations show up 
iii. Click “Next” 

 

 

 

STEP  15.e.i. 
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f. You will proceed to the Text Import Wizard – Step 3 of 4 dialog 
i. Click to the right of the station decimals to create a line as shown below 

ii. Verify your window looks like this and all stations show up 
iii. Click “Next” 

 

g. You will proceed to the Text Import Wizard – Step 4 of 4 dialog 
i. Under Column Data Format, select “Station” 

ii. Verify your window looks like this and all stations show up 
iii. Click “Finish” 

 

 

 

STEP  15.g.i. 



PIN: S3DF.VA Appendix C-Designer Workflow 

Page 17 of 25 

h. The window below will appear, Click “OK” 

 

i. Both windows will disappear 
j. In the InRoads© program window, choose “Geometry” > “Vertical Curve Set” > 

“Events” 
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k. Verify all stations are present along with corresponding elevations and click “Close” 

 

 

 

 

 

 

 

 

 

 

 

STEP  15.k. 



PIN: S3DF.VA Appendix C-Designer Workflow 

Page 19 of 25 

16. Open the Bentley Civil Report Browser 

 

17. Got to “Tools” > “Format Option” 
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18. Set the Northing/Easting, Station and Elevation precision to FOUR decimal places 
19. Choose “Close” 

 

20. Close the Bentley Civil Report Browser 
21. In the InRoads© program window, choose “Tools” > “XML Reports” > “Geometry” 

 

 

 

 

 

 

 

 

STEP  18 

STEP  18 

STEP  19 
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22. The Geometry Report dialog opens 
a. Select the locator button under Horizontal Alignments next to “Include:” 
b. Select the alignment in the Microstation© drawing window and the alignment will 

appear under “Selected:” 
c. Check “Include Vertical Alignment”, Select “Active” under “Include Vertical Alignment” 

i. Verify the TOP OF WEB vertical alignment is active under GIRDER X 
d. Check “Include Vertical Event Points” 
e. Click “Apply” 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

STEP  22.a. 

STEP  22.b. 

STEP  22.c. 

STEP  22.d. 

STEP  22.e. 
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23. The Bentley Civil Report Browser dialog will open 
a. In the left pane select the “VerticalEvents.xsl” report (See picture below) 

i. All stations imported from the text file should appear with Northing, Easting, 
Elevation and Grade values 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

STEP  23.a. STEP  23.a.i. 
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b. In the Bentley Civil Report Browser dialog, choose File > Save As 
i. Under “Save as type:”, choose “XLS File (*.xls)” 

ii. Navigate to the folder where you want to save the report 
iii. Enter filename as shown 
iv. Click “Save” 

 

c. Close the Bentley Civil Report Browser dialog 
24. Close the Geometry Report dialog 
25. Open the “PIN_GIRDER X_TOP OF WEB.xls” file created in STEP 23.b 

a. The following message window will appear, Click “Yes” 

 

 

 

 

 

 

 

 

 

 

 

 

STEP  23.b.i. 

STEP  23.b.iii. 

STEP  23.b.ii. 

STEP  23.b.iv. 
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26. Copy in the point names from STEP 4, Column 1 and paste to the right of the Grade column (See 
below) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

27. If there are two points that have the same station, note this in the description column with both 
point descriptions 

STEP  27 

STEP  26 
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28. In Excel©, Select “Save As” 

 

a. Save file as “Excel Workbook (*.xlsx)” 

 

29. YOU ARE DONE!!  This file will be submitted as part of the deliverable 

STEP  28.a. 
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Appendix D 
Representative Scan Results 
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